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Twixl Publisher: The basics

Twixl Publisher consists of several components:

1. Twixl platform: an online platform where you'll manage your app and its content.
2. Twixl app: install this app on your mobile device and you can scan the QR code of
your app on the platform, so you can experience the complete look and feel of

your app before building it.
3. Twixl macOS app: when you are ready to publish your app, you can build your
app on a Mac with the Twixl Publisher application.

Twixl Publisher has a lot more to offer. With our InDesign plugin you can export your
interactive InDesign content and import it on the Twixl platform. With the Twixl macOS
app you can preview your app in the iOS simulator, or on a device (tablet or phone)
with the Twixl Viewer Classic app. You can share this with other people so they can
review your app's content before it's published on the App Store or Google Play Store.

This ‘Getting Started’ guide is intended to help you understand the basic concepts of
Twixl Publisher. So let us guide you first through the different steps of creating apps with
Twixl Publisher.

The starting point for every Twixl app is the Twixl platform. That’'s why you need a TwixI
account to sign in to the Twixl platform tom manage your app(s).

You can create one or more app project(s) on the Platform. They will be listed on the
Projects page, which is where you arrive after you sign in to the platform.

After creating a project, select it on the Projects page and start managing it. You'll notice
that the project's menu is divided into various sections, such as Content, Design, Access,
etc. In the Twixl documentation, we typically begin by guiding you through the options in
the menu bar on the left.

@ E.g Menu> Content > Collections > Settings
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.TI.I.IIXL PLATFORM — 0 2 TwiiDemo - -

These are the components of a projects page on the Twixl platform:

1. User menu: Here you can find all user and admin elements, a help section and a
search bar.

2. Breadcrumb & Project Info: The breadcrumb allows you to check where you are on
the Twixl platform and lets you navigate to other sections easily. At the right, you can
click on Project Info for a pop-up with more info on the project, the App Key, QR code...

3. Menu bar on the left: Contains all the different sections of your app project.

4. Page title: So you know where you are and you can already perform quick actions by
selecting anicon.

5. Page section: Depending on the selection you made in the left-hand menu bar, you
will get to different page sections that contain the content, design elements, and so
much more.

The success of your app largely depends on a good user interface. To control all design
elements, there is a 'Design’ section in the menu bar. There you will find (amongst others):

1. Configuration: General design settings for your navigation bar and specific pages.
More info: Configuration.

2. Grid Styles: When browsing your app, all elements on the page are displayed in a
grid. You can define different grids that you can use on different browse pages. More
info: Grid Styles.

3. Item Styles: The thumbnails of your content will be displayed on the selected grid for
that page. But how these thumbnails will be presented, is defined by item styles. You
can use different item styles on one grid and use them across different grids. More

info: ltem Styles.
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@ To help you with the interface in your app, there are 2 special types of collections:

1. Root Collection: This is the first page, the 'home page' if you like, that users will see
when they start the app. It is a starting point in the app.

2. Hamburger Menu: This is an optional feature that we strongly recommend. It will
show a hamburger icon in the title bar of the app so your app user can navigate
to other sections or perform some general actions (like logging in) easily.

More information about the concept of Twixl Collections can be found in the next
chapter.

0 Except for the Root Collection, all other collections are equal. So, for your
interface, you can link from any collection to any other collection as there is no
hierarchy between collections.

In Twixl terminology, these are 2 very important concepts:

1. Contentitems: These are the different kinds of content that you want to show to your
user, e.g. content exported from InDesign ( .article or .publication ), HTML
content, PDFs, movies, images,.. Check Content Items for a complete overview.

2. Collections: All content items are uploaded into Collections. The Root Collection and
Hamburger Menu are special collections (see above). More info: Collections.

@ Although we consider one should start with some design elements in your
project, the Content section is positioned just below the Home segment. This is
because, once your app has been set up and designed, you will use the upload
features in Content a lot more.

In the sample apps, we have already uploaded some content items in collections with
specific item styles in grid styles. So you can already preview it ‘as is’ with our Twixl App.

Install and use the Twixl App:
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« On your mobile device (phone or tablet), download the “Twixl App" from the App Store
or from the Google Play store.

« Open the Twixl app, then scan the QR-code for your app on the Twix| platform, and
you can check the preview.

@ You can always easily access the QR code by clicking on the scanning icon in the
breadcrumb bar, or from the Project Home.

Twixl offers a lot more settings and features for your app.

Manage what your users can see for free or what is offered as a purchase by using
subscriptions and/or entitlements. Make your app accessible on desktops using the
Browser Client. Alert your users about new content using Push Notifications. Upload
content automatically via RSS feeds or more. And much more!

The last step is to build a real' iOS and/or Android app with the Twixl macOS application.
Note that you need a production app (i.e. an active Twixl subscription) for this. Read all

about building your app here: Getting started with the Twixl macOS app

@ WHAT'S NEXT?

Now you know the basic steps to create and build an app with Twixl Publisher
and master the most important terminology, you can dive in to each of these
more into detail on this next help page:

- Start to create your first app

When you want to add colleagues to your Twixl account that will be working on
the Twixl platform too:

* Manage Team

Some important general pages:

. System Requirements
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2. Downloads
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Start to create your first project

Every Twixl app begins with the creation of a Project on the Twixl platform.

In Twixl, we use the term Project to refer to everything that happens behind the
scenes like all the setup, design configuration, content management,...

When we refer to an App, we mean the final product - the version that end users will
download and install on their mobile devices.

When you first log on the Twixl platform, your Projects page is empty. Let's start creating
your first project by clicking the '+"icon.

TWiXL PLATFORM

PI’OjthS [:' DEMO (TRIAL ACCOUNT)

Name 7| Mode 7! Updated On 7.
No projects.
Create your first project

New to Twixl?
Discover the basics here

When you add a Twixl Project on the Twixl platform for the first time (in trial mode), you
can choose from several "templates” to get you started. For more info about each of

these templates, see: Getting Started sample app or Kiosk sample app.
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PROJECTS > ADD NEW PROJECT

Project mode

Select your first project to start exploring Twix|.

TIWXL SAMPLE APP

Getting started

S ——
New App Getting Started App Kiosk App
Empty app Contains sample content Contains sample content

For demo purposes only For demo purposes only
more info more info

Cancel

@ \WWhen you have created your first project, you will always create a new project
from scratch. Then your first page will ask you to select a Project Mode
(development or production). The idea is that you start with a Development
project and once your Development project has been tested and approved, you
can then copy or change this Development project into a Production project so
you can start building and distributing your app to app users.

PROJECTS > ADD > PROJECT MODE

Project Mode

Select the mode for your new Project depending on the goal.

Development Production
For testing purposes For building and distribution purposes

Cancel
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Once you have selected a template app or the Project Mode, enter the required
information in the Project Details.

Add New Project

DEVELOPMENT MODE

Project Details Project Icon

Name * Storage Type * (1)
|| Twix| Storage

Description

« Name*: This is the name of the project on the Twixl platform. This can be different
from the name that your app’s users will see on their device (which is defined in Build
Settings).

+ Description: Here you can add information about the project so you can differentiate
it immediately in the project list overview page. This description isn't used anywhere
else.

* This field is required before you can start creating a Twixl project.

 Projectlcon: You can add an project icon to make it easier to identify your project in
the project list on the Twixl platform. This is different from the icon that will be used to
build your app which is also defined in Build Settings.

You can now click 'Save' to store the Project Setup for your first Project on the Twixl
platform!

Once your project is created, you can always return to the Project Setup page by:

+ Clicking on 'Project Setup' in the Menu bar.

« Opening the 'Project Info' icon (top right in the breadcrumb bar) and clicking on the
‘edit’ icon.

« On the Home page, selecting the settings icon.
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Project Details Project Icon

Name * App Key
[ Twix|-Demo cc6596fc7d66734a8bfc71311f783902 @
Description Storage Type

App for demo purposes only Twixl Storage

Storage Region

Europe

You will now also see these fields:

« App Key: This is a unique Twixl identifier that is asked for when you contact Twixl
Support so we can immediately check the project you are working on.
+ Storage type: By default this is set to Twixl Storage.

Storage region: This field indicates the region where your account is stored so you will
be able to get faster responses from the Twixl platform.

Allow Users to access this Project

authorize all unauthorize all
Users

App Reviewer (app_reviewer, App Reviewer)

Reviewer (reviewer@twixlmedia.com, App Reviewer)

 Allow Users to access this Project: Here you can define which other users can access
this project. More info about Managing Users can be found here.

+ Design the interface of your app
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+ Add content to your app
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Project Setup

Project Setup lists all basic elements of the project on the Twixl platform right from
the start. What is the name of your project? Who can access the project? ...

Via Platform > Menu > Bottom: Project Setup

Project Details Project Icon
Name * App Key
[TwixI—Demo cc6596fc7d66734a8bfc71311f783902 0
Description Storage Type

App for demo purposes only Twixl Storage

Storage Region

Europe

« Name: This is the name of the app project on the Twixl platform. This is not the name
that will be used to show to your app users.

 Description: Free field you can use to specify what this project is used for. This field will
only display on the projects list page but not in the app.

« App key*: This is a unique identifier of your project that has been given to your TwixI
project automatically. It will be asked when you contact Twixl Support.

- Storage Type*: By default, this will be Twixl Storage.

+ Storage Region*: This is the primary region where your storage will be hosted and this
is selected by the region of where your account was signed.

+ ProjectIcon: You can add an application icon to make it easier to identify your project
in the project list on the Twixl platform. This icon is not shown to your app users.

@ The fields marked with * cannot be changed once attributed.

Project Access

Team Members (i) authorize all unauthorize all
App Administrator o
Apple Review

Getting started Page 14
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+ Allow Team members to access this Application: Here you can define which other
users (other than Admin roles) can access this app. More info about Managing your
Team can be found here.
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More about the Getting Started sample app

This article explains the concept behind our Getting Started app.

The purpose of this sample app is to demonstrate some of the things that are possible
with Twixl Publisher, to get you started and to make sure you understand the basic
workflow. The app is meant to just give you an impression, it is neither a real nor a
finished project. It's a basic app with the three main types of content (InDesign-based,
HTML and PDF), a Hamburger Menu and support for the Browser Client, in addition to iOS
and Android.
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A LEGAL INFO:

This app and its contents can be used for demonstration purposes only. It
cannot be used for other commercial purposes without prior consent from Twixl
media bv.

- Legal Notices
+ General Terms & Conditions

@ ABOUTSAMPLE APPS:

Please remember that you can play around with Sample Apps. In other words:
the default settings can always be changed!

It has a Hamburger Menu
« It has a Browser Client activated

« It has different Browse Grids & Iltem Styles

« It has mainly 3 types of content: Twixl articles (InDesign-based content items), HTML
articles, PDF content items.

« It supports downloading of content for offline access.
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Twixl Publisher Getting Started

)L SAMPLE APP
®

Getting started

.

Indesign baged article | “ . /

e

HTML The

collection libra ry

Q How did we do it?
We'll show you, clear and simple. Just click the
“Gear icon on every page.

Placeholder with an image (logo) and text
Placeholder with text, functions as the title of the app
Collection Link that links to an InDesign-based article
Collection Link that links to an HTML-article
Collection Link that links to a Collection The Library
Web Link that links to this KB-article!

OOk wN -

Getting started
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< Twixl Publisher Getting Started The Library

FACES MAGAZINE FACES MAGAZINE
Issue Number 1- PDF Issue Number 2 - InDesign

FACES MAGAZINE FACES MAGAZINE
Issue Number 3 - InDesign Issue Number 4 - HTML

@ 304

1. Placeholder with an image (logo) and text
2. Collection Link that links to a Collection with 1 PDF Content Item in Detail Mode
3. Collection Link that links to a Collection in Detail mode, containing several TwixlI

articles

4. Collection Link that links to a Collection in Detail mode, containing several Twixl

articles

o1

Getting started

Collection Link that links to a Collection in Detail mode, containing 1 HTML article
6. Web Link that links to this KB-article!
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@ Twixisample App

@ HTMLCollection

@ Thelibrary

@®> Main story;
‘

@ Privacy
@ v Of

Placeholder with an image (logo) and text

Collection Link that links to a Collection in Detail mode, containing 1 HTML article
Collection Link that links to a Collection The Library.

Collection Link that links to a Collection with an InDesign-article

Web Link that links to a mailto link

Web Link that links to our Privacy Policy

Web Link that links to our Twitter Feed

Web Link that links to our Facebook page

ONO Ok WN

This app has sample content. You can download the original files below. The
InDesign content was created with InDesign CC2020. The HTML content was
created with Blocs.app but you can use obviously any other tool to create your
HTML.

Faces Magazine 1 (PDF)
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Faces Magazine 2 §InDesignl
Faces Magazine 3 (InDesign)
Faces Magazine 4 (HTML)

+ Styling: Custom Fonts

« Styling: Grid Styles

« Styling: Item Styles
+ Hamburger Menu

» The Browser Client
+ Managing content downloading
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More about the Kiosk sample app

This article explains the concept of our Kiosk app. It's ideal if you want to create a
traditional kiosk app.

The purpose of this sample app is to demonstrate how to create a traditional Kiosk App.
The app is meant to just give you an impression, it is neither a real nor a finished project.
It's a kiosk app with PDF Content Items, a Hamburger Menu and support for the Browser
Client in addition to iOS and Android.

A LEGAL INFO:
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This app and its contents can be used for demonstration purposes only. It
cannot be used for other commercial purposes without prior consent from TwixI
media bv.

- Legal Notices
+ General Terms & Conditions

@ Please remember that you can play around with this app, and change settings
as you wish!

* It has a Hamburger Menu

+ It has the Browser Client activated

+ It has different Browse Grids & Item Styles

« It has several types of content mixed in the app.

« It supports downloading of content for offline access.
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X Demo app - Kiosk [:B

This month:
MAGAZINE #1
File type: PDF

MAGAZINE #2 MAGAZINE #3
Type: InDesign Type: HTML

ﬁg How did we do it?

1. Banner highlighting your brand or baseline. Can also be an image (logo) and text
that links to a website. You could also use an Inline or Embedded Web Viewer, if you
want to implement a Web Banner.

2. Featured Issue:is a Collection Link with text and an image that links to a PDF Content
Item.

3. Legacy issues: linking to InDesign and HTML content.

+ Styling: Custom Fonts
+ Styling: Grid Styles

+ Styling: Item Styles

+ Hamburger Menu

« The Browser Client

« Managing content downloading
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More Getting Started
pages
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Getting started with the Twixl design
basics

In order to choose the look and feel of an app, Twixl offers the concepts of ‘grid styles’
and ‘item styles’ to determine how your content is presented to app users.

Grid styles are assigned to Collections and can be different for different collections.
Item Styles are assigned to Content Items and they will define how content items will
be displayed in the selected grid for the collection your content item is in.

You can access these interface design elements via Platform > Design.

The grid style determines how the content of a collection in browse mode will be
displayed on a ‘grid’ in your app. In this grid, each content item can be displayed using a
particular size. Check the screenshot below of a grid that uses 6 columns (a 'grid style’),
and where each item on that grid spans a specified number of columns. Different
collections in your app can have different grid styles applied to them. Learn more about

Grid Styles.

6X2
BANNER

4X2 2X2
ARTICLE1 ARTICLE 2

2X2 2X2
ARTICLE 3
2X2 2X2 2X2
ARTICLE 3 ARTICLE 4 ADVERTISEMENT
r—
—

—
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The appearance of the content item cells in your browse pages will be determined by the
Item Style selection. Item Styles are defined in Design > Item Styles where you can add
new item styles by clicking on '+" and selecting a template from the list. You can later

adjust the style to match your requirements.

ltem Style

.
Title .
Title

adipiscing elit. Aliquam tempus felis sit
amet sem euismod consectetur.

Title & Text Title Only

Title

Lorem ipsum dolor sit

amet, consectetur

adipiscing elit. Aliquam .
tempus felis sit amet. Title

Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Aliquam tempus felis sit.

Image Right Image Top

Title Title

Lorem ipsum dolor sit
amet, consectetur
adipiscing elit. Aliquam
tempus felis sit amet.

Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Aliquam tempus felis sit
amet sem euismod consectetur.

Text & Full Image Image Left

Image Only Empty

As you can see, a couple of template examples are:

 Atitle and a subtitle for an article
+ A title on an image background

« An image to the left or right of a title & subtitle

* And many more ...

After selecting, you can continue to further adjust your |tem Style.

In the design section, you can find more elements that can enhance the user experience:

- Configuration: where you define how the overall elements (like navigation bar, search
page...) in your app will look like and how your app will behave (e.g. all data offline...).

« Background Images: in addition to defining a background color for your collection in
browse view, you can also use an image as the background for the thumbnails of your

content items.

« Custom Fonts: Twixl also supports the use of custom fonts in your app so the fonts you
use in the item styles match your corporate style or the look and feel you want.
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@ Make sure to install the Twixl app on your mobile devices before you start
working on grid and item styles. That way you can immediately check how
changes to your design look like in the app on your device. More information
about the Twixl app here.
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Getting started with content for your app

Now that you have designed the interface for your app, you can start adding content
to your app. In this chapter, we will discuss all elements that you can find in the
‘Content’ section (in the menu bar on the left) on the Twixl platform. As already
mentioned, content is added to collections in the Twixl ecosystem.

@ Content %

Root Collection
Hamburger Menu
Collections

Content Items

@ Though all listed items on this page match the order of the content section on
the Twixl platform, we advise to first think about the structure your app needs.
Start by creating collections, add content items and finally link to these
collections from the root collection and hamburger menu.

The Root Collection is a special collection type as it can be considered to be the Home
page of the app. When a user opens the app, the Root Collection will be displayed and it
is the page where one goes back to if one wants to go back to the first entry point.
Depending on the purpose of your app, the Root Collection can list different navigation
options (e.g. a sales app) or new items (e.g. news app) and is mandatory for every app
published with Twixl Publisher.

The Hamburger Menu is another special collection type as it will display a hamburger
icon in the right corner of the menu bar throughout the app. This makes the Hamburger
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Menu ideal to navigate quickly to other sections of the app or add some quick action
buttons (Iogin/logout, search, library, downloads...). By default, the Hamburger Menu is
disabled as it is an optional collection.

Collections group all your content items that belong together. A collection can be a issue
of a magazine where the pages are all different content items. But a collection can also
be a set of similar magazines (e.g. one year per collection) where every content item is
an entire magazine (depending on your content item type). Collections can also target
specific users by handling different subjects (e.g. an HR section in an enterprise app).
Finally, Collections can display a list of the content items that are uploaded to the
collection (Browse view) or can start by showing the first content item in the collection
(Detail view).

All content that you want to offer to your user, can be found in Content Items. Here you
can upload different types of files like InDesign export files, HTML files, PDF files, movies,
images,... and add them to collections.

You can also think about uploading content automatically via:

+ Content Sources
+ APl integration
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Getting started to build your app

Once your app design has been setup and content has been added to the Twixl
platform, you are ready to build your app and upload it to the stores. This Getting
Started article will guide you through the different steps to distribute your app.

@ Distributing apps on Apple's App Store and Google Play Store is a bit different as
both stores have different requirements.

» For the App Store: make sure you have an Apple Developer Account and your

signing certificates.
+ For the Play Store: make sure you register for Google Play App Signing.

@ To build apps with an Apple Silicon Mac, first register your device on the Apple
Developer Portal.

The Twixl building process is handled via 2 different Twixl components:

« The Twixl platform
+ The Twixl Publisher macOS application

In the Twixl platform, you will need to create a Build Setting where you will define your app
icon, launch image; enter your bundle ID(s), Apple Team ID and other settings (e.g. if you
want to use Push Notifications, Google Analytics...).

Check Twixl platform > Menu > Build > Build Settings

Once you have defined a build setting on the Twixl platform, you can create builds via the
Twixl Publisher macOS Application. A folder will be created on your Mac with 2 subfolders

(i0s and/or Android, depending on your selection) containing the builds to upload to the
Stores.
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The macOS App also allows you to preview and share InDesign content on your device or
in a simulator.

A You can only build Twixl apps on a Mac as creating iOS builds requires the use of
Xcode, Apple's Integrated Development Environment. You'll need to sure you
have Xcode installed and set up on your computer (but don't worry, you don't
need to be a programmer).

» Deploying your iOS app in App Store
» Deploying your Android app in Google Play Store

@ Of course, you can also choose to only distribute your apps in-house, both for
i0S and Android.
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Getting Started in InDesign

Before opening InDesign, make sure you have installed the Twixl Publisher plug-in
according to these instructions.

When you have started InDesign, select the Window menu, then navigate to Extensions
-> Twixl Publisher to open the palette. You will notice a number of options are available in
the palette.

If no object is selected in InDesign, the publication management options will be available.

If a certain object (like a movie or image) is selected, depending on the type of object,
the relevant options for different interactive elements will be displayed.

¢ Twix| Publisher 15.3

Publication Article

Properties Publication

Preview Publication Article

Publication Article

Publication Article

Separate Articles

Alternate Layouts

Preferences

When creating InDesign content with Twixl Publisher, there are two different
approaches to creating your content:

1. Article-based
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Create individual articles that can be uploaded to a collection on the Twixl platform -
this works best when multiple designers are working on content for the same app, or
when you have an app with frequently updated content.

2. Publication-based

Create a complete publication, using an InDesign book to manage the different
articles - this works best if only one designer is working on the publication. When
importing a Twixl publication to an app on the platform, it will automatically be split
into a collection with individual articles for each of the InDesign articles.

You can decide to create and export individual articles separately. When you export an
article, the exported file will have the extension .article.

Just zip that .article file, and it can be uploaded to the platform.

For more details about adding content to your app, please check Working with Content
ltems.

Twixl Publisher supports 5 different sizes, each of them in landscape and portrait:

- iPad (1024x768 and 768x1024 pixels)

« Android 10 inch (1280x752 and 752x1280 pixels)

« Android 7 inch - Kindle Fire (1024x552 and 552x1024 pixels)
+ Phones (568x320 and 320x568 pixels)

« Phones XL (852x393 and 393x852 pixels)

New articles or publications created by the Twixl Publisher plug-in will use a specific
naming convention for the alternate layouts:

« iPad: "iPad H" for landscape and "iPad V" for portrait

« Android 10 inch: "Android 10" H" for landscape and "Android 10" V" for portrait

« Android 7 inch: "Kindle Fire/Nook H" for landscape and "Kindle Fire/Nook V" for portrait
« Phones: "Phone H" for landscape and "Phone V" for portrait

« Phones XL: "Phone XL H" for landscape and "Phone XL V" for portrait

o IMPORTANT NOTE:

If you create documents manually, i.e. by selecting New Document from the File
menu instead of using the plug-in's 'New article’ menu option), make sure your
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alternate layouts use the naming convention above, and that your documents
have the page size Twixl Publisher expects. If you have layouts with a different
name, you'll receive an error message during preflight.

Publication Properties

Name | AvantGand
TOC Viewer Title Bar Button
Initial Article
Template iPad Landscape
File Name | Table of Contents
Title

Tag Line

Show Templates Folder...

Select "New Publication”. Once you select a publication name and optional issue number,
the plug-in will create a "book” in InDesign.

An InDesign book file is a collection of documents that can share styles, swatches,
master pages, and other items.

There are two options for displaying your Table of Contents (TOC):

« Title Bar Button (default)
« If you do not want to display a TOC viewer at all, select the option "None®

If you choose "Title bar button..” a TOC icon will appear in the right corner of the title bar,
that will become visible when tapping anywhere on a page of your publication. If you
also defined a hamburger menu in your app, it will appear to the left of that menu.
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Hospitality special

INTRO

% HOTELROOMS
@ WELLNESS

CONFERENCE AND MULTIFUNCTIONAL AREAS
@ BAR AND RESTAURANT

i @ OUTDOOR AREA

[
VELTRIESS JBESTRI

Initial article

You can create the first article of your publication, as well as select its title and optional
tagline (these will be displayed in the TOC Viewer).

You can also select your starting template. The template you select for your first article
will become the default template for that publication.

Getting started Page 36



TI.I.IIXL LEARN & SUPPORT

Setup & Requirements
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System Requirements

Recent versions of Adobe InDesign on macOS or Windows.

The Twixl Publisher application requires macOS Sonoma 14.x or higher for building iOS
apps.

What's New

Xcode 15.2 includes Swift 5.9 and SDKs for iOS 17.2, iPadOS 17.2, tvOS 17.2, watchOS 10.2, visionOS, and macOS Sonoma 14.2.
This update adds support for the visionOS SDK to create apps for Apple Vision Pro.

Preview

o =0~ s ~NEe JE ) & =) =l 00D ~Be =

Xcode will allow you to build iOS apps and to get a preview of your app in the iOS
simulator. The components panel of the macOS app will alert you if it needs to be
installed or updated.

« Xcode is a free download from the Mac App Store.

* In order to create app builds that can be installed on a device, or to submit apps in
the App Store, you need at least Xcode 16 and need to be registered as a developer in
the "iOS Developer Program® (99$/yr): Start here to enroll now.
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A IMPORTANT NOTE:

After installing Xcode, make sure to follow all the steps described here.

- Android SDK: the Android SDK needs to be available to create Android builds.
The System Check in preferences allows you to check for the presence of the Android
SDK and offer to install it if it's unavailable, or update it if a newer release is available.

+ In order to submit Android apps in the Google Play store, you need a Google Play
account.

Below is an overview of the different OS and app versions that are supported by Twixl
Publisher.

(refers to the OS versions required to install the apps on those devices)

* i0S:15.x or higher
+ Android: 9.x or higher

(refers to the versions required for creating app builds)

* macOsS: Ventura 13.x or higher

« Xcode: Xcode 15.x or higher for building and submitting apps (to support the latest iOS
versions and devices, you should always us the latest version).

A IMPORTANT NOTE:

To submit mobile apps (.ipa) to the App Store, you need the Transporter App. See
this article.
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We recommend either Safari or Chromium based (Chrome, Edge, Brave...) as browsers to
have an optimized experience on the Twixl platform.

Getting started Page 40



TI.IJIXL LEARN & SUPPORT

Installation

First download from our downloads page, then copy the Twixl Publisher.app from the disk
image to your Applications folder. When opening this app, you will be prompted to install
or update the InDesign plug-in if it has not been installed yet, or if it needs to be updated.
The plug-in will then become available in InDesign from the menu Window -> Extensions.
You also need to install the Twixl Publisher Helper.

In order to build iOS apps, Xcode as well as the latest iOS SDK need to be installed. For
Android, the Android SDK needs to be downloaded.

Components

In order to use Twix| Publisher, a number of components need to be installed on your computer.

| Android SDK 20240215-1720-arm64 is installed

Plugin version 22.4 is installed
Find it in Adobe InDesign > Window > Extensions

v Xcode is installed (Platform: 17.5)

Helper version 22.4 is installed

i0S 17.5 (21F79)

Double click the Twixl Publisher.exe installer to install the plug-in for all supported
versions of InDesign that are installed on your system.

The plug-in will become available in InDesign from the menu Window -> Extensions.
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Check for updates...

@  Twixl Publisher File Edit Tools Window Help

About Twix| Publisher

Preferences...
Check for updates... N
Services >

Hide Twix| Publisher
Hide Others
Show All

Quit Twix| Publisher

When the Twixl Publisher macOS app starts up, it checks whether an update for the
application is available.

If an update for the app itself is available, it will display the release notes and offer to
download it.

You can also manually select "Check for updates..” from the Twixl Publisher application
menu.
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Components

In order to use Twix| Publisher, a number of components need to be installed on your computer.

Android SDK 20240215-1720-arm64 is installed

Plugin version 22.4 is installed
Find it in Adobe InDesign > Window > Extensions

Xcode is installed (Platform: 17.5)

Helper version 22.4 is installed

i0S 17.5 (21F79)

When the Twixl Publisher macOS app starts, it also checks the status of several
components, and will report if a component needs to be installed or updated.

It will display information about the following checks:

« Twixl Publisher plug-in: if not up to date, you can click to update

 Twixl Publisher Helper: if not up to date, you can click to update

- i0S SDK (part of Xcode, required for iOS simulator previews and app builds): if not
installed, you can click on the ‘Install’ button

- Android SDK (required for Android app builds): if not installed, you can click on the
Install’ button

If all components are up-to-date, the Twixl Publisher app will not show a red exclamation
mark.
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Licensing information

If you purchase a Twixl Publisher subscription, the license is managed on the Twixl
platform. When your subscription has been processed, you'l receive an email that
contains your Twixl license Key. The message will also contain instructions on how to
activate your license key on the Twix| platform. For subscription renewals, the license key
will be updated automatically.

Check your licensing information by clicking on your name in the top bar > Account
Detals

PROJECTS > ACCOUNT: TWIXL MEDIA

Account: Twixl media

Subscription

Your local partner: Twixl media Direct
Account manager:

Tel:

Email:

Subscribed user
Expiration date: 18 Jan 2038
Twixl Publisher - Unlimited Multi with Pro Pack - yearly subscription (legacy)

# Production Apps: Unlimited

License Key
45LH8PMS

Replace License Key

Getting started Page 44



TLI.IIXL LEARN & SUPPORT

Working with custom storage

Publishers that use the Twixl platform, and that have very high download volumes,
have the option to use their own storage account on Amazon $3 or Microsoft Azure.

0 IMPORTANT NOTE:

DIY storage is only available as an option for subscribers of the Twixl Publisher
10+ plans. Also, if you use DIY storage, you do not have the benefits of using the
Akamai Content Delivery Network (CDN).

If the custom storage option has been activated for your account, you will be able to
select the storage type when adding new apps. Select Amazon S3, then enter the Acces
Key and Secret Access Key for your account, along with the region where you want the
content to be hosted.

If the custom storage option has been activated for your account, you will be able to
select the storage type when adding new apps. Select Windows Azure, then enter the
Account Name and Account Key for your account.
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Downloads
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Downloads

Downloads
 Twixl Publisher for macOS consists of an application that allows you to build your iOS
and/or Android apps, and also lets you install the Twixl Publisher plug-in for InDesign.
 Twixl Publisher for Windows will install only the Twixl Publisher plug-in for InDesign.
« Build Twixl apps for iOS & Android (on a Mac)
+ Preview the result on your tablet or phone
« Share your articles/publications with colleagues and clients

# Download on the 5 GETITON

| App Store B\ Google Play
# Download on the R GETITON

¢ App Store ;\ Google Play

+ The Twixl app lets you preview your complete app in real time on your device, and

lets you share it with others.
+ Twixl Viewer Classic lets you preview content from InDesign with the Twixl Publisher

plug-in.
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TWIXL PLATFORM

« On the Twixl Platform, you can create a sample app (or a completely new empty app)
and define its interface from scratch, preview your app's content and share it with

others.
« During your 30-day trial, all extra paid options like the Entitlement Pack, Integration API

and Automated Content Sources are enabled by default, so you can play around with
these features if you wish.

Release Notes

These are InDesign files with samples of the different interactive features.

Example Files

Older versions
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Release Notes

Release notes
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PDF Manuals

0 LATEST UPDATE:

28 Aug 2025

Here you can download a PDF of the main chapters in our documentation.

Getting started
Manage content
Design the interface
Create in InDesign
Build your app

Access to your content
Advanced Features

Analytics
More features
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Platform management
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Manage your Team

Twixl uses RBAC (role-based access control) to provide different types of pre-defined
roles for users. Here, we explain how to do that and which types of roles are available.

To manage team members in your account, one needs to have an Admin role. Initially,
this is the primary user that has been assigned when creating your account in Twixl.
Once you start adding team members, you can add multiple Admin roles if needed.

Adding team members, changing roles... all this can be performed via ' Manage Team.

Where: Platform > User Menu > Your user > Manage Team

2 Twixl Demo ~ Q@

| User Profile

Account Details

(-

Sign out

How to add a team member: Platform > User Menu > Your user > Manage Team > Invite
team member

Now fill in all the fields:
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Invite Team Member

Team Member

Role *
=mselect,--

User Name *

Email Address *

Full Name *

Job Title

Password

Password *

Repeat Password *

Role: Select the role your team member will have in the account (see below).
User Name: The name your team member will use to access the Twixl platform.
Email Address: The email address that will be used to send the invite to.

Full Name: The name that will be indicated in the team member list so you can
identify the team member.

5. Job Title: Extra non-mandatory field to add additional information like the job title.
6. Password: Enter a password so the team member can access the Twixl platform.

PON -

The password can always be changed by the user or the Admin.

@ We do advise the password should be changed as soon as the new user enters
the Twixl platform. For additional security, we also advise to enable 2 Factor
Authentication.

Different types of users can be created on the Twixl platform:

1. Administrator: has full access to the account - can manage account, all apps &
team members.

App Administrator: has full access to the selected app(s) - cannot manage account
or team members.

App Designer: has access to the design and content sections of the selected app(s).
App Content creator: has access to the content section of the selected app(s).

App Coordinator: can manage users in entitlement section of the selected app(s).
App Builder: has access to the build section of the selected app(s) - can create a
build of the selected apps with the macOS app.

N

o0k w
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7. App Reviewer - can only review selected apps by scanning the QR code on the Twixl
platform with the Twixl app. See this article.

8. App Report Viewer - can access analytics of selected apps on the Twixl platform -
cannot manage account, apps or team members.

For more details, check this overview.
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2 Factor Authentication (2FA)

2FA adds an extra layer of security to your user account as it requires an extra
confirmation code before entering the Twix| platform.

Two-Factor Authentication (also known as 2FA) is about an extra layer of security. It
requires not only a password and a username but also something else. In other words: it
is the authentication process where two of the three possible factors of authentication
are combined.

The possible factors of authentication are:

1. Something the user knows (e.g.: a password, PIN code, an answer to a secret question,
)

2. Something the user has. (e.g.: a token, a mobile phone, a USB, ...).

3. Something the user is (e.g.: face or voice recognition, fingerprint, ...).

For internet security, the most common used combinationis: 1 + 2 .And that's what we
use on the Twixl platform.

Login on the Twixl platform

Go to your User-account and click on your Username in the menu.
Select the first item in that Dropdown-menu: Logged in as: username .
Select Two-Factor Authentication.

Follow the instructions!

ok wN ~

+ Google Authenticator
« Microsoft Authenticator
- 1Password

+ Authy

@ GOODTOKNOW:
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« A good password remains important. It's your first and most important layer of
security. Don't neglect it!

« Activating 2FA on the Twixl platform is not a requirement, but we strongly advise
you to do so.

- 2FA cannot be activated for all users at once (for the same Account). Activating
2FA is initiated by the user.

« You should think about activating 2FA on other (non-Twixl) accounts as well. The
more accounts have a better security, the less chance you have in creating a
chain reaction when an important account is compromised.

Security is the responsibility of both service providers and users!
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Deleting an app on the platform

An app on the Twixl platform can be deleted. Here's how to do it, but make sure to first
check the consequences of this procedure!

o WARNING:

This process is irreversible! Proceed with extreme caution!

To delete an app on the Twixl platform, you need to:

Twixl platform > Projects

Next to the project name you want to delete > Click on 'More actions’
Select 'Delete project’

Read the warnings and confirm as described

POON -

@ [f auserdecides to delete an app, the Twix| platform will delete all info related to
the deleted app:

Content
Analytics
Settings

Due to GDPR-regulations, this process is irreversible! Depending on the size of
the app, this process will take about 1 minute maximum.

As a result, readers will no longer have access to the content of your app.
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